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1 Preamble 

About this manual 

This manual contains specific information on the VisiWinNET VWE Manager, among others 
general advice, the operating reference, and the runtime error diagnosis. 

Questions and Problems 

For technical questions and problems please contact your responsible INOSOFT agent or the 
INOSOFT GmbH Support under +49 (5221) 16 66 02 or email: Support@INOSOFT.com 

Frequent questions and problems are dealt with on our homepage under www.inosoft.com 

There you will also find a support area for direct contact with our Main Office. 
 

http://www.inosoft.com/
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2 VWN-Manager 
 The VWN-Manager in Stand-By operation (before project selection) 

 The VWN-Manager in routine operation (after project start, Cursor moves) 

 The VWN-Manager with not acknowledged system error (red flash) 

In routine operation the VisiWin-Engine-Manager (VWN-Manager) is located as a little 
icon with a yellow bridge next to the computer clock in the task bar (also wrongly called 
tray area). It includes a flash-in menu operated by right mouse click in which 
configuration can be proceeded with, process variable (Items) states can be displayed 
and the system diagnosis logbook can be viewed. Following system functions are 
combined in the VWN-Manager: 

2.1.1 Data collecting (VisiWin-Engine) 
VisiWin Engine (also VWEngine or briefly VWE) supplies all process data from the 
connected controlling, field buses and other data suppliers to the superior visualization 
(VB-Application). The data collecting is processed through a standardized OPC-Interface 
or else with specific drivers (VisiWin Drivers). It can be processed optional in the 
sampling procedure (polling mode with fixed sampling rate) or asynchronous with 
changed process data. The two operating modes can also be merged.  

Following data types are supported: BIT, BYTE (signed/unsigned), WORD (signed 
/unsigned), DWORD (signed/unsigned), REAL (single/double precision), DATE (Windows-
Date format), structures and fields of all these data types. 

2.1.2 VWN-Server-Container 
Additionally the VWN-Manager is a container, in which various data processing 
programs (VWN-Server) can manage and interpret the existing PLC data. On the system 
side, following is being delivered along at present: Alarm system, User administration, 
Recipe-/Format administration, Trend-/Archive system, VB-Formula-Compiler and Text- 
and Language administration.  

Using an available tool kit for creation of characteristic servers, written in C++, 
customer specific data processing options can be realized. There is a data interface, with 
which the available data points can be read out and written easy and fast. In addition all 
running servers will be informed about the queuing system massages. Characteristic 
system messages can be created and the system logbook can be accessed as well. Many 
VWN-Servers (i.e. the Alarm systems have their characteristic interface to the VB-
Application (here, Alarm list, alarm line). 
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2.1.3 Client-Server operation 
In the Single-Application-Operation the VB-Application as well as the VWN-Manager 
can be found on the identical data processor. They communicate through the Windows-
COM-System. The VWN-Manager is boots automatically with the VW-Application start. 

In the Client-Server Operation one or more VB-Applications (Clients) and the VWN-
Manager (Server) are located on different data processors and communicate through 
Windows-DCOM then. In this case the VWN-Manager can either be booted with data 
processor start of the server data processor or else by the first client to be connected. 
There the VWN-Servers run on the server data processor as well and serve all clients at 
the same time. 
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2.1.4 Overall view of the coherences 

VWE-Manager

VWE-Communicator

VWEManager in system

Alarm system

VisiWinNET -Applications

VWEngine

Archive system

Recipe system

Language switching

User administration

special VWE-Server

OPC-Server/
VisiWin-Driver

PLC
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2.2 VWN-Manager menu structure  

2.2.1 Main menu 
The Default-function, which can also be reached through a double click on the VWN-
Manager-Icon, is marked in bold type. Before a project was started, it is the Start-menu, 
while operating it is the VWEngine. 

 

Start Starts data collecting and VWN-Servers manually (i.e.: in the 
client-server mode or for diagnosis purpose). Normally the 
VWN-Manager is started automatically by the VB-Application. 

Stop Stops data collecting manually. 

Configuration VWEngine and diagnosis settings 

Diagnosis Display of log book 

Server list Lists and states of the started VWN-Servers 

Acknowledge errors If a system error occurred (VWN-Manager flashes red) it can be 
acknowledged here. Then it will also be acknowledged in the 
alarm lists/ -lines of the VB-Application. 

Engine Access to the VWEngine, all data points (Items) can be 
displayed and manipulated here. 

Exit Manual closing of VWN-Manager 
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2.2.2 Start 
Data collecting for one of the projects, registered on the data processor can be started 
manually for diagnosis purposes. 
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2.2.3 Configuration 

 

Common  Log book settings 

 clear logbook at 
startup 

With every application start the logbook will 
be created new. 

 Logbook online at 
startup 

The diagnosis display (also see diagnosis) is 
immediately „online“ with first diagnosis 
menu call. Entries, registered in the logbook 
in the course of the application, appear 
directly in the diagnosis window. 

 log only errors Only system error but no system information 
is recorded in the logbook. 

Logbook 
format 

 Log book design settings. 

 Date, time, 
Milliseconds 

Selected time and date will be recorded. 

 Difference Time difference to the previous logbook 
entry will be recorded in milliseconds. 

 Source Information on the source of the logbook 
entry will be recorded. 
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OPC  OPC-Client configuration 

 Start OPC server 
simultaneously 

Either parallel start of all connected OPC-
Servers or start in succession. The setting 
can be used if the OPC-Servers, used in the 
project are initiated on another data 
processor in the network. Thus, the OPC-
Server start will not stress the system 
resources of the data processor. Therefore, 
the parallel start speeds up the initialisation 
phase. 

 Time outs on local 
OPC-Server 

Determines, whether function calls in an 
OPC-Server, located on the identical data 
processor as the VWN-Manager, are to be 
monitored per timeout (with remote OPC-
Servers this happens automatically) 

Watchdog  Settings for cycle time monitoring of the 
VWEngine. If the current cycle time is ten 
times bigger than preset, it is considered 
that a system component does work incorrect 
and causes a system error. An optional 
Watchdog-Server can react adequate, i.e. 
restart the data processor. 

 disable watchdog Turns off the internal monitoring of process. 

 manually timeout Switch between automatic and manually 
selected cycle time limits. 

 ms System cycle Here, optionally another cycle time limit, 
than the automatic preset (10 x preset cycle 
time), can be registered for the system clock 
(in milliseconds). 

 ms async. Trend cycle  Here, optionally another cycle time limit, 
than the automatic (10 x preset cycle time) 
can be registered for the minimum Archive- 
(Trend-) recording cycle. (In milliseconds). 
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Timeouts  Various System-Timeout-Settings 

 s RPC (Remote 
Procedure Call) 

Time, after expiration a COM- or DCOM 
function call (i.e. to an OPC-Server or to a 
VB-Application (Client)) will be judged as 
incorrect. After time expiration the existing 
connection to the communication partner 
will be cancelled. With OPC-Servers, after a 
certain period of time, specified under Auto-
Restart, the OPC-Server will be restarted. If 
the connection to a VisiWinNET-Client is 
abandoned, the client will try to establish the 
connection again.  

 s OPC Start Time, after expiration the system generates an 
error if the OPC Server doesn't start. An OPC 
server has to answer the status requests during 
this period with "OPC_STATUS_RUNNING" or 
"OPC_STATUS_TEST". 

 S OPC Status  Time, after expiration the system generates 
an error if the OPC Server doesn't answer 
with his configuration status 
("OPC_STATUS_NOCONFIG" or 
"OPC_STATUS_SUSPENDED").  

 s Auto Restart Period of time, upon expiration an OPC-
Server will be restarted if the connection was 
abandoned. The OPC-Server is inquired 
cyclic for its status, with the "AutoRestart"-
time, even when the data transfer is running. 
Thus, a lapse of the OPC-Server can be 
diagnosed. 

Modes of 
Diagnostic  

 Which types of diagnosis are to be switched 
on/off 

 Log book If selected, all system output created in the 
system will be saved in the file, specified 
under logbook. 

 Message-Boxes With a system fault a message dialog appears 
on the display including the error message 
content and must be acknowledged. (The 
system runs in the background, all messages, 
which occur parallel are written into the 
logbook). 

 Alarm With a system fault an entry is created in the 
Alarm system as well (Alarm list, Alarm 
line). 

 Beep With a system fault an alarm signal is heard. 

Menu-Hotkey  The main menu of the VWN-Manager can 
also be shown through the indicated key 
combination (i.e. if a mouse is not available). 
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Logbook Circular cache The logbook is designed as a circular cache 
i.e. if the content exceeds the value specified 
in the “Size kB” field the oldest entries are 
overwritten. 

 by the day Every day a new file is created. In the process 
the date of the log file is added to the file 
name. 

 by the hour Every hour a new file is created. In the 
process the date and time of the log file are 
added to the file name. 

 Size kB  Determines the maximum size of the log file. 
The size is adjustable between 10kB and 
2MB. 

 File name The file name (including the path indication) 
of the created logbook. This is saved in 
simple text format. 

Debug output  Via this button a dialog is opened allowing 
the selection of additional diagnosis output 
for particularly error-prone system 
commands. If support is required additional 
options can be activated here following 
instructions by the INOSOFT Hotline. 
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2.2.4 Diagnosis (Log book display) 
Within the diagnosis the last part of the entire log book (the last 32 Kbytes of 1Mbyte 
max. log book size) can be inspected. Thus, information about the system status and 
queuing system errors is provided. In chap. 2.3 an example log book is shown with 
several respective explanations. 

 

Online The log book display can be switched between Offline-Mode (standing 
display, Scrolling ability) and Online-Mode (refresh, display of 
incoming system messages) 

Print Log book printout on the default printer 

Clear Deletion of the entire log book 

Top Go to the beginning of the log book 

Bottom Go to the end of the log book 

Acknowledge Acknowledge current system fault (red flashing of VWN-Manager will 
disappear, the system alarm will be acknowledged in the alarm list/-
line) 
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2.2.5 Server list 
A list including the VWN-Servers, started at the moment, the logged-on client 
applications and the used VWEngine is being displayed with current state and Release 
number. 

 

2.2.6 VWEngine 
Dialog for display and change of process variables (Items). 
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Variable selection  The variable (VWItem) to be displayed or 
changed can be selected here. 

 Structures Structures, created in the process variable 
definition table, or else all single variables 
(„@-Items-@“) can be selected. 

 Variables Structure members or single variables can 
be selected. 

 Variable type Only variables of a certain data type are 
listed. 

 Structure type Obsolete 

   

Variable display  Information about a variable (VWItem) and 
the current variable value is displayed. 

 Variable Variable name (ItemID within the 
VWEngine) 

 Value Current value 

 Bit format Current value in binary format 

 Address Respective ItemID within the OPC-Server 
or address in the VisiWin-driver of the 
variable 

View  The value of the selected variable will be 
displayed in the variable view. 

Change Bit  A single bit of an variable can be changed 

 Bit Bit number to be set 

 Bit = 1 Bit is set to „1“ 

 Bit = 0 Bit is set to „0“ 

Change value  The variable value can be changed 

 Change value The new variable value 
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Track variable  Adds the variable selected in the variable 
selection to the tracking list. 

Tracking list  Opens the dialog for editing the tracking 
list. All variables in the list are “tracked” 
i.e. all VWEngine actions involving these 
variables (import of changes from the 
communication component, logon/logoff 
incidents from the clients, …) are 
automatically recorded in the log files. 

The dialog offers the options of deleting the 
entire tracking list or individual varables. 

2.3 VWN-Manager diagnosis (Server Log book) 
In the log book of the VWN-Manager all proceedings and system faults, which occur in 
the data collecting- and administration system during the application runtime, can be 
followed. According to the configuration (also see 2.2.3) the log book can have various 
looks. A typical example is shown here (manual VWN-Manager start on the Server data 
processor with project „VisiTest“): 

File: C:\VisiWin\VisiWinNET\Log\VWNManager.log 

09.01.2002 17:47:17.390  <VWN-Manager>  System is being initialized 

09.01.2002 17:47:25.371  <VWN-Manager>  IDLE -> DESIGN: VisiTest 

09.01.2002 17:47:25.371  <VWN-Manager>  RUNFORDESIGN 

09.01.2002 17:47:25.492  <VWN-Manager>  Start Kernel  

09.01.2002 17:47:25.842  <VWEKernelOPC>  Connect to OPC-Server: VWOPC.Demo.1 

09.01.2002 17:47:25.972  <VWEKernelOPC>  OPC-Server (VWOPC.Demo.1) supports 

*IOPCShutdown-Interface*, Shutdown connected 

09.01.2002 17:47:25.972  <VWEKernelOPC>  OPC-Server (VWOPC.Demo.1) is running 

09.01.2002 17:47:26.173  <VWEKernelOPC>  Group "OLK2_Standard" in OPC-Server 

"VWOPC.Demo.1" created – demanded scan rate: 

250, assigned scan rate: 300 

09.01.2002 17:47:26.243  <VWEKernelOPC>  Status in group "OLK2_Standard" changed in 

OPC-Server "VWOPC.Demo.1" - Status: ACTIVE, 

assigned scan rate: 300 

09.01.2002 17:47:26.463  <VWEKernelOPC>  Software protection check: 20000 Power tags 

allowed, 414 existing Power tags  

09.01.2002 17:47:26.463  <VWEKernelOPC>  Software protection check: 1000 interfaces 

allowed, 1 existing interface  

09.01.2002 17:47:26.583  <VWN-Manager>  VWN-Server -> DESIGN: 

VWTextServer.TextController 

09.01.2002 17:47:26.603  <VWN-Manager>  VWN-Server -> DESIGN: 

VWAlarmServer.AlarmInterface 
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09.01.2002 17:47:26.824  <VWN-Manager>  VWN-Server -> DESIGN: 

VWTrendServer.TrendController 

09.01.2002 17:47:26.904  <VWN-Manager>  ChangeRunMode: successful 

09.01.2002 17:47:26.904  <VWN-Manager>  DESIGN -> RUN: Visits 

09.01.2002 17:47:26.924  <VWN-Manager>  VWN-Server -> RUN: VWTextServer.TextController 

09.01.2002 17:47:26.924  <VWN-Manager>  VWN-Server -> RUN: 

VWAlarmServer.AlarmInterface 

09.01.2002 17:47:26.924  <VWN-Manager>  VWN-Server -> RUN: 

VWTrendServer.TrendController 

09.01.2002 17:47:26.924  <VWN-Manager>  Kernel runs  

09.01.2002 17:47:26.934  <VWEKernelOPC>  SetDefaultValues: INIT_VALUES 

09.01.2002 17:47:26.944  <VWN-Manager>  >> ProjectRunning 

. . .     

09.01.2002 18:47:50.769 ! <VWEKernelOPC>  OPC-Server abnormal terminated: VWOPC.Demo.1 

09.01.2002 18:47:50.769  <VWEKernelOPC>  Try to disconnect from OPC-Server: 

VWOPC.Demo.1 

. . .     

09.01.2002 18:48:00.784  <VWEKernelOPC>  Try to reconnect to OPC-Server: VWOPC.Demo.1 

09.01.2002 18:48:00.964  <VWEKernelOPC>  Connect to OPC-Server: VWOPC.Demo.1 

09.01.2002 18:48:01.204  <VWEKernelOPC>  OPC-Server (VWOPC.Demo.1) supports 

*IOPCShutdown-Interface*, Shutdown connected 

09.01.2002 18:48:01.204  <VWEKernelOPC>  OPC-Server (VWOPC.Demo.1) is running 

09.01.2002 18:48:01.204  <VWEKernelOPC>  Successfully reconnected to OPC-Server: 

VWOPC.Demo.1 

09.01.2002 18:48:01.284  <VWEKernelOPC>  Group "OLK2_Standard" in OPC-Server 

"VWOPC.Demo.1" created – demanded scan rate: 

250, assigned scan rate: 300 

09.01.2002 18:48:01.465  <VWEKernelOPC>  Status in group "OLK2_Standard" changed in 

OPC-Server "VWOPC.Demo.1" - Status: ACTIVE, 

assigned scan rate: 300 

09.01.2002 18:48:01.465  <VWEKernelOPC>  Item reconnection succeeded - OPC-Server: 

VWOPC.Demo.1 

09.01.2002 18:48:01.465  <VWEKernelOPC>  SetDefaultValues (VWOPC.Demo.1): ERROR_VALUES 

. . .     

09.01.2002 19:48:29.197  <VWN-Manager>  RUNFORREDESIGN 

09.01.2002 19:49:29.197  <VWEKernelOPC>  Transfer of "OPCShutdown" to OPC-Client: 1 
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09.01.2002 19:49:29.197  <VWN-Manager>  VWN-Server -> STOP: 

VWTextServer.TextController 

09.01.2002 19:49:29.197  <VWN-Manager>  VWN-Server -> STOP: 

VWAlarmServer.AlarmInterface 

09.01.2002 19:49:29.197  <VWN-Manager>  VWN-Server -> STOP: 

VWTrendServer.TrendController 

09.01.2002 19:49:29.347  <VWEKernelOPC>  SetDefaultValues: EXIT_VALUES 

09.01.2002 19:49:29.347  <VWN-Manager>  Kernel stopped 

09.01.2002 19:49:29.347  <VWN-Manager>  STOP 

09.01.2002 19:49:29.347  <VWN-Manager>  VWN-Server -> EXIT: 

VWTextServer.TextController 

09.01.2002 19:49:29.377  <VWN-Manager>  VWN-Server -> EXIT: 

VWAlarmServer.AlarmInterface 

09.01.2002 19:49:30.379  <VWN-Manager>  VWN-Server -> EXIT: 

VWTrendServer.TrendController 

09.01.2002 19:49:30.479  <VWEKernelOPC>  Try to disconnect from OPC-Server: 

VWOPC.Demo.1 

09.01.2002 19:49:30.579  <VWEKernelOPC>  Successfully disconnected from OPC-Server: 

VWOPC.Demo.1 

09.01.2002 19:49:31.180  <VWN-Manager>  DESIGN -> IDLE: VisiTest 

09.01.2002 19:49:32.211  <VWN-Manager>  Running down of system  

09.01.2002 19:49:32.221  <VWN-Manager>  ... closed 

The example log book includes following information: 

Date Time + ms F Source Text entry 

At 17:47:17.390 on January 09th. 2002 the system was started, Text administration, 
Alarm system and Archive system were initialized. 

At 17:47:26.944 the system was booted up completely and in “Run”-Mode. 

At 18:47:50.769 the connection to the VisiWin-Demo-OPC-Server abandoned. 

At 18:48:00.784 reconnection to the VisiWin-Demo-OPC-Server was tried (10 s Auto-
Restart time setting (also see chap. 2.2.3)). 

At 18:48:01.465 it succeeded, default values for the error case were set successfully. 

At 19:48:29.197 the instruction for running down the system was given. 

At 19:49:32.221 the system was run down completely. 
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2.4 The VWN-Manager as OPC-Server 
The VWEngine itself is structured as OPC-Server. Therefore the VWEngine variables 
(Items) can be accessed by any OPC-Client with only little restriction. All common 
interfaces (Browse items, item logon, synchronous and asynchronous read- and write 
instructions) are supported.  

The ProgID of the VWEngine, independent of the Release number, reads as follows: 
„VisiWinNET.OPCServer“ (VisiWinNET OPC-Server V2.1).  

With item browsing the ItemID’s or alias names are presented according to the 
configuration. 

Following restriction applies with the VWEngine operation: 

• The project can only be initiated through a VisiWinNET-VB-Application or else manually 
(also see 1.2.2). Only then an OPC-Client can connect to the VWEngine. If the VWEngine 
is not yet started, the OPC-Client receives an error message „CO_E_APPNOTFOUND“ 
with the creation of the OPC-Server Object. (0x800401F5, Application not yet started). 

• Only one OPC-Client at a time can connect to the VWEngine, additionally to the 
VisiWinNET-Clients. 

• If the VWEngine is run down through the VB-Application or manually, the connection to 
the OPC-Client will be disconnected. 

• The VWEngine does not support the OPC-CALLR-Interface for dynamic creation of items. 
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3 Error messages 
Possible error messages of the system in the diagnosis (apportioned by descent): 

3.1 Alarm system („VW-Alarm Server“): 
Nr Error text Description Remedy 

101 Speicher geplatzt System memory not sufficient System error, no unoccupied Windows-
memory capacity, Task-Manager -> check 
system performance 

110 Access to the VWE-Kernel The VWEngine was not yet started 
completely 

Check log file of previous error 

111 Variable X could not be logged on; 
Variable to be acknowledged 

The acknowledgement variable X, listed in 
the alarm group definition could not be 
found in the process database (Use of 
capital and small letters?) 

Select variable again 

112 Variable X could not be logged on; 
Deactivation variable 

The deactivation variable X, listed in the 
alarm group definition could not be found 
in the process database (Use of capital and 
small letters?) 

Select variable again 

113 Variable X could not be logged on; 
Status variable 

The status variable X, listed in the alarm 
group definition could not be found in the 
process database (Use of capital and small 
letters?) 

Select variable again 

114 Variable X could not be logged on; 
Priority variable 

The priority variable X could not be found 
in the process database (Capital and small 
letters?) 

Select variable again 

115 Alarm X could not be allocated to 
the alarm class Y 

The alarm class Y of this alarm X could not 
be found 

Check alarm affiliation to a alarm class 

116 Variable X could not be logged on, 
Alarm variable 

The event variable X, listed in the alarm 
definition could not be found in the process 
database (Use of capital and small letters?) 

Select variable again 

117 Variable X could not be logged on, 
Acknowledgement variable 

The acknowledgement variable X, listed in 
the alarm definition could not be found in 
the process database (Use of capital and 
small letters?) 

Select variable again 

118 Variable X could not be logged on, 
Status variable 

The status variable X, listed in the alarm 
definition could not be found in the process 
database (Use of capital and small letters?) 

Select variable again 

119 DB-Template was not found in the 
resource 

The template for the historical alarm 
archives could not be found in the resource 
of the alarm server 

Alarm server (VWAlarmServer.DLL) neu 
aufspielen und registrieren 

120 DB-Template in the resource 
incorrect 

The template for the historical alarm 
archives was destroyed in the resource of 
the alarm server 

Alarmserver (VWAlarmServer.DLL) Install 
and register again 

121 DB-Template in the resource; 
Access denied 

The template for the historical alarm 
archives could not be read out in the 
resource of the alarm server 

Alarmserver (VWAlarmServer.DLL) neu 
aufspielen und registrieren 

122 DB could not be created: X Historical alarm archive X could not be 
created 

Check indicated path and file name (the 
file might be write-protected?) 

123 Access to the IndexTextServer 
failed 

In this project the text server was not 
started, does not exist or else is not 
registered (required for language-
switchable alarm text) 

VWTextServer.DLL neu aufspielen und 
registrieren oder unter „VisiWinNET -> 
Project properties -> Server components -
> activate VWLanguage“ 
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Nr Error text Description Remedy 

124 Access to the VWS-configuration 
failed 

Access to the project database (“Project 
name.VWS”) through 
VisiWinNET.CfgAccess.EXE failed 

VisiWinNET.CfgAccess.EXE neu aufspielen 
und registrieren 

125 Archive-Trigger variable not 
specified (X), historical alarms 
cannot be relocated 

In the alarm configuration (“Alarm Editor -
> Tools -> Configuration“) TRIGGER was 
selected as file change event, but not 
Trigger variable was input 

Select variable again 

126 Archive-Trigger variable could not 
be logged on (X), historical alarms 
cannot be relocated 

In the alarm configuration (“Alarm Editor -
> Tools -> Configuration“) TRIGGER was 
selected as file change event, but the 
Trigger variable was not found in the 
process database 

Select variable again 

128 Expand_File name, wrong 
formatting with X, current 
parameter: n, existing number of 
parameters: m 

Wrong format label (n. Parameter of m) 
with historical archive name (“Alarm Editor 
-> Tools -> Configuration -> File name“) 
found 

Enter file name again 

129 Formatting error, data types 
incompatible - parameter: n 
Formatting: c 

The data type of the indicated parameter is 
incompatible to the selected formatting, 
historical archive name (“Alarm Editor -> 
Tools -> Configuration -> File name“) 

Enter file name again 

130 Parameter-error in the file name 
n: unknown VW-Variable: X 

The indicated parameter (Variable, Item) 
cannot be found in the process database, 
historical archive name (“Alarm Editor -> 
Tools -> Configuration -> File name“) 

Select variable again 

131 Table X in Y could not be opened The indicated table X could not be found in 
the process database Y 

System error, call Inosoft hotline 

133 AlarmServer-lock could not be 
created 

Memory for access lockout (semaphore) 
could not be created  

System error, no free Windows-memory, 
Task-Manager -> Check system 
performance  

134 "Indextexts in Indextexts" are not 
supported with language-
independent alarm management 
(Indextext X). 

The formatting ‚@I’ and ‚@G’ are not 
supported with the historical archive name 
creation (“Alarm Editor -> Tools -
>Configuration -> File name“) 

Enter file name again 

135 Table X in the project database Y 
could not be opened 

The database table X could not be found in 
the project database Y (extended, user-
defined alarm information)  

Structure of the user-defined alarm 
information was not created correctly -> 
„Free parameter sets“ in the alarm 
definition 

136 Database key X could not be 
found the table Y in the project 
database Z. 

The database index X could not be found in 
the database table Y in the project 
database Z (extended, user-defined alarm 
information  

Structure of the user-defined alarm 
information was not created correctly -> 
check „Free parameter sets“ in the alarm 
definition 

137 Alarm output channel X could not 
be found in the table Y in the 
project database Z 

The free parameter X could not be found in 
the database table Y in the project 
database Z (extended, user-defined alarm 
information  

Structure of the user-defined alarm 
information was not created correctly -> 
check „Free parameter sets“ in the alarm 
definition 

138 Alarm number X with alarm 
output channel Y could not be 
found in the table Z in the project 
database W 

The additional information (free parameter 
Y) to this alarm X could not be found in the 
database table Y in the project database Z 
(extended, user-defined Alarm information  

Structure of the user-defined alarm 
information was not created correctly -> 
check „Free parameter sets” in the alarm 
definition 

139 Alarm could not be saved in X The data set to be archived (historical 
alarm) could not be saved in the indicated 
archive X 

Check path- and file name of the indicated 
file 
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3.2 Trend- / Archive system („VW-Trendserver“): 
Nr Error text Description Remedy 

101 Speicher geplatzt System-Memory is not sufficient System error, no more free Windows-
memory, Task-Manager -> check system 
performance 

110 Access to the VWE-Kernel The VWEngine was not yet started 
completely 

Check log file of previous error 

111 Variable X could not be logged on, 
Trigger variable 

The Trigger variable X, specified in the 
archive definition -> Recording could not 
be found in the process database (Use of 
capital and small letters?) 

Select variable again 

112 Variable X could not be logged on, 
Start-Stop-Variable 

The Start-/Stop variable X, specified in the 
archive definition -> Recording could not 
be found in the project database (Use of 
capital and small letters?) 

Select variable again 

113 Variable X could not be logged on, 
Reset-Variable 

The Reset- variable X, specified in the 
archive definition -> Recording could not 
be found in the process database (Use of 
capital and small letters?) 

Select variable again 

114 Variable X could not be logged on, 
X-Axis-Variable 

The X-Axis variable X, specified in the 
archive definition -> Recording could not 
be found in the process database (Use of 
capital and small letters?) 

Select variable again 

115 Trend X could not be allocated to 
the archive Y 

The archive to the indicated trend could 
not be found in the archive definitions 

Check archive name 

116 Variable X could not be logged on; 
trend variable 

The Trend variable X, specified in the 
trend definition -> Standard could not be 
found in the process database (Use of 
capital and small letters?) 

Select variable again 

117 Variable X could not be logged on, 
maximum variable 

The Maximum variable X, specified in the 
trend definition -> Recording could not be 
found in the process database (Use of 
capital and small letters?) 

Select variable again 

118 Variable X could not be logged on, 
minimum variable 

The Minimum variable X, specified in the 
trend definition -> Recording could not be 
found in the process database (Capital and 
small letters?) 

Select variable again 

119 Variable X could not be logged on, 
maximum substitution value 
variable 

The maximum substitution value variable 
X, specified in the trend definition -> 
Recording could not be found in the 
process database (Capital and small 
letters?) 

Select variable again 

120 Variable X could not be logged on, 
minimum substitution value 
variable 

The minimum substitution value variable 
X, specified in the trend definition -> 
Recording could not be found in the 
process database (Capital and small 
letters?) 

Select variable again 

121 Variable X could not be logged on, 
error-value variable 

The error substitution value variable X, 
specified in the trend definition -> 
Recording could not be found in the 
process database (Capital and small 
letters?) 

Select variable again 



VisiWinNET VWE-Manager 

Error messages / Trend- / Archive system („VW-Trendserver“): / VWEngine    22 

 

Nr Error text Description Remedy 

122 Variable X could not be logged on, 
hysteresis variable 

The hysteresis variable X, specified in the 
trend definition -> Recording could not be 
found in the process database (Capital and 
small letters?) 

Select variable again 

123 Asynchronous trend cycle could 
not be started 

The trend for the asynchronous data 
recording could not be started. 

Call Inosoft Hotline 

124 Trend archive full X - Trend Y In the trend Y in the archive X the default 
number of data records is reached, but no 
swapping-out possibility is given. 

Check file change event in archive 
definition -> Format 

125 Variable X could not be logged on, 
swapping-out variable 

The file trigger variable X, specified in the 
archive definition -> Format could not be 
found in the process database (Capital and 
small letters?) 

Select variable again 

126 Archive X could not be opened Y 
times. 

In the archive X, Y times no new data 
record could be saved 

Is the file being accessed from another 
process at the same time, or is the file 
write-protected? 

127 Asynchronous trend cycle could 
not be stopped - Handle:X ID:Y 

The trend with handle X and ID Y for the 
asynchronous data recording is waiting for 
an event and cannot be closed 

The trend will be closed automatically 
external if necessary, possibly the latest 
data record will not be saved correctly 

128 Asynchronous trend cycle could 
not be stopped regularly 

The trend for asynchronous data recording 
is waiting for an event and cannot be 
closed 

The trend will be closed external 
automatically if necessary, possibly the 
latest data record will not be saved 
correctly 

129 Trend data request – wrong 
archive-ID: X 

A trend control requests recorded data of a 
not existing archive. 

Check archive property in the trend 
control 

130 Trend data request - Interval 
provides wrong type: X 

The request interval of a trend control for 
recorded data provides the wrong data 
type (i.e. of an archive, provided with X-
axis variable specification data of exact 
time 1 to exact time 2 is inquired, correct 
would be of x-value 1 to x-value 2) 

Check between-/and-property in the trend 
control 

132 ? Asynchronous trend cycle started 
already - Handle:X, ID:Y 

The trend for asynchronous data recording 
was not closed properly with a former start 

Information message 

133 Archive X cannot be saved, blank 
VisiWinEngine.doc 

The file name specified in the archive 
definition -> Format is expanded to a 
blank file name (i.e.: file name from text 
variable, text variable is blank) 

Check file name declaration 

135 In a ring buffer archive X (Archive-
ID: X, Trend-ID: Y) data is to be 
saved, though the size is specified 
with 0 entries 

In an archive of the Type „Ring buffer“ 0 
was stated as ring buffer size 

Check ring buffer size declaration 

136 In an archive X (Archive-ID: X, 
Trend-ID: Y) data is to be saved, 
though no known type is stated 
(Sequence archive, Ring buffer 
archive, etc.) 

With the archive definition X another type 
as „Ring buffer“ and „Sequence archive” 
was stated. 

Check archive type 

137 VWS-Configuration access failed Project database access (“Project 
name.VWS”) through 
VisiWinNET.CfgAccess.EXE failed 

Start and register 
VisiWinNET.CfgAccess.EXE again 

138 Archive definition not found - 
ArchiveID:X 

A trend control inquires recorded data of a 
not existing archive. 

Check Archive-Property in the trend 
control 

139 Trend definition not found - 
ArchiveID:X TrendID:Y 

A trend control inquires recorded data of a 
not existing trend of archive Y 

Check Trend-Property in the trend control 

140 Table X in Y could not be opened The stated table X could not be found in 
the project database Y 

System error, call Inosoft hotline 
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Nr Error text Description Remedy 

141 Data set X in the table Y in Z could 
not be changed 

An archive definition X could not be 
changed in the table Y in the project 
database Z 

System error, call Inosoft hotline 

142 Manual file change, possible only 
with event-controlled archives: X 
(ID: Y) 

Creation of new archive files through the 
trend interface is possible only with the 
file change event „Never“ 

Check file change event 

143 Watch-dog for asynchronous trend 
cycle: logon or ping failed 

Watch-dog for the asynchronous data 
recording trend could not be activated 

System error, call Inosoft hotline 

144 Formatting error, Types 
incompatible - Parameter: X 
Formatting: Y 

The data type of the specified parameter is 
incompatible to the selected formatting, 
Archive definition -> Format -> file name 
(“Alarm Editor -> Tools -> Configuration 
-> File name“) 

Re-enter file name 

145 Parameter-error in the index text 
X: VW-Variable unknown: Y 

The stated parameter (Variable, Item) 
cannot be found in the process database, 
Archive definition -> Format -> File name 

Select variable again 

146 ExpandText, wrong formatting 
with X, current Parameter: X, 
existing number of parameter sets: 
Y 

Wrong formatting characters found (n. 
parameter of m) with archive definition -> 
Format -> File name 

Re-enter file name 

148 Data type of variable X could not 
be determined 

The Trend variable data type could not be 
determined correctly 

Stated variable in trend definition -> 
Check Standard -> Trend variable 

149 File could not be archived 
historical (Rename X to Y), Error: Z 

With relocation of an archive file (Rename 
X to Y) an error Z occurred 

The file already exists or it is write-
protected or else the file name contains 
illegal characters or a wrong path 
declaration. Check the stated file names. 
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3.3 Recipe- / Format administration („VW-Recipe server“): 
Nr Error text Description Remedy 

101 
Speicher geplatzt System memory not sufficient System error, kein Windows-Speicher 

mehr frei, Task-Manager -> Check system 
performance 

102 
This server is not supporting 
VisiWin32! 

The recipe server can only be used with 
VisiWinNET 

Recipe server declaration on a VW32-
Channel is inadmissible 

110 
VWE-Kernel could not be found The VWEngine was not yet started 

completely 
Check Log file on previous error 

111 
VWS-Configuration access failed The project database access (“Project 

name.VWS”) through 
VisiWinNET.CfgAccess.EXE failed 

Start VisiWinNET.CfgAccess.EXE again 
and register 

112 
Stated table X in Y not found The stated table X could not be found in 

the project database Y 
System error, call Inosoft hotline 

113 
Recipe definition variable X could 
not be logged on 

The variable X, specified in the recipe 
definition -> ItemID could not be found in 
the process database (Use of capital and 
small letters?) 

Select variable again 

114 
Accessory recipe class (X) to the 
recipe variable Y not found 

With recipe variable assignment to a 
recipe definition an error occurred 

Check recipe variable (ItemID) in recipe 
definition 

115 
Recipe variable X to the recipe 
class Y could not be logged on 

Sub-recipe name variable (Recipe 
definition -> ???) X to the recipe 
definition Y could not be found in the 
process database (Use of capital and small 
letters?) 

Select variable again 

116 
In the recipe class X (Y) no name 
variable is stated, though triggers 
are stated for the variable-
controlled recipe administration. 
The recipe definition is incorrect 
and will not be activated. 

In the recipe definition with the recipe -> 
Load trigger or Save trigger or Read 
trigger or Write trigger a variable is given, 
but not under recipe -> Standard -> 
Recipe file name. However, this is 
necessary or else the recipe name cannot 
be determined with the trigger setting 

Select a recipe name variable under recipe 
-> Standard -> Recipe file name 

117 
Table X in the database Y could 
not be opened 

The specified table X could not be found in 
the project database Y 

System error, call Inosoft Hotline 

119 
Key Code X in table Y could not be 
found in the database Z 

The database index X could not be found 
in the database table Y in the project 
database Z (extended, user-defined Alarm 
information)  

Project database structure is not correct 
(possibly after update to a new Release)-> 
call Inosoft Hotline 

120 
Specified recipe class (X) could not 
be found in a recipe order (File 
name: Y) 

An unknown recipe class was given for a 
load- or save order to (from) a file Y 

The recipe interface was called with a 
wrong recipe class (Check VB-Source code) 

121 
Error with opening of the database 
X 

The project database could not be accessed Cannot find process database. (Write-
protected ?) 

122 
Table could not be opened, table: 
X in database Y 

The given table X could not be found in 
the project database Y 

System error, call Inosoft Hotline 

123 
VWE-Kernel-Interface not 
available, abnormal termination 

The VWEngine was not yet started 
completely 

Check log file on previous error 

124 
Data could not be saved, table: X 
in database Y 

Error with opening of table X in recipe file 
Y 

The file is possibly write-protected or the 
file name consists invalid characters or 
else a wrong path declaration 



VisiWinNET VWE-Manager 

Error messages / Recipe- / Format administration („VW-Recipe server“): / VWEngine    25 

 

Nr Error text Description Remedy 

125 
Blank recipe definition variable (X) 
stated for recipe class Y 

Sub recipe name variable (Recipe 
definition -> ???) X for recipe definition Y 
was not given 

Select variable 

126 
Blank recipe order (???, recipe 
class: X (Y)), file name: Z 

An unknown recipe order for the recipe 
file Z of the recipe class X was started 

Check VB-Source code with recipe 
interface call 

127 
No file name given to this recipe 
order (recipe class: X (Y)) 

No file name was given for a load- or save 
order for the recipe class X 

Check VB-Source code with recipe 
interface call 

128 
Max. size (X) of the recipe order 
list reached (recipes cannot be 
worked off fast enough 
apparently), order (recipe class: Y 
(Z), file name: W) denied 

The recipe order list is full (the size can be 
defined under Recipe definition -> 
Options -> Configuration -> Number of 
orders at the same time) 

Reduce the recipe order frequency or 
adjust the recipe order list size (Recipe 
definition -> Options -> Configuration -> 
Number of orders at the same time) 

129 
COM-Memory for this inquiry 
cannot be created (X – recipe class: 
Y) 

System-memory not sufficient System error, kein Windows-Speicher 
mehr frei, Task-Manager -> Check system 
performance 

130 
Start of asynchronous recipe 
administration failed 

Trend for asynchronous recipe processing 
could not be started 

Call Inosoft Hotline 

131 
Recipe name cannot be determined 
or else is blank, Recipe class: X 

Current recipe file name cannot be 
determined from the recipe name variable 

Check recipe name variable specification 
in the recipe definition  

132 
Recipe name variable is of wrong 
data type, Recipe class: X 

Current recipe file name cannot be 
determined from the recipe name variable 

Check recipe name variable specification 
in the recipe definition (no valid recipe 
name can be determined from the given 
variable) 

133 
Scheduled value variable X login 
not possible, though a standard 
quantity is given (Recipe class: Y 
(Z)) 

The variable X, specified in the recipe 
definition -> Enhanced -> Scheduled 
factor variable could not be found in the 
process database (Use of capital and small 
letters?) 

Select variable again 

134 
Scheduled quantity cannot be 
determined (Recipe class: X (Y)) 

With the inquiry of the current scheduled 
quantity target for recipe class X an error 
occurred. 

Check recipe definition -> Enhanced -> 
Scheduled factor variable (possibly the 
data type is not valid, i.e.: text variable) 

135 
Error with XML-Component access As file format for recipe files XML is 

selected (Recipe definition -> Options -> 
Configuration -> XML), but the recipe files 
cannot be accessed correctly 

XML-DOM was not set up correctly, is to 
be selected with the SetUp-wizard 

136 
Unknown error with XML-
Component access 

As file format for recipe files XML is 
selected (Recipe definition -> Options -> 
Configuration -> XML), but the recipe files 
cannot be accessed correctly 

XML-DOM was not set up correctly, is to 
be selected with the SetUp-wizard 

137 
DB-Template not found in the 
resource 

The recipe file template in MSAccess-
format (Recipe definition -> Options -> 
Configuration -> MSAccess) could not be 
read from the resource of the recipe server 

Set up and register recipe server 
(VWRecipeServer.DLL) again 

138 
Incorrect DB-Template in the 
resource 

The recipe file template in MSAccess-
format (Recipe definition -> Options -> 
Configuration -> MSAccess) in the 
resource of the recipe server was 
destroyed 

Set up and register recipe server 
(VWRecipeServer.DLL) again 

139 
DB-Template in the resource, 
access denied 

The recipe file template in MSAccess-
format (Recipe definition -> Options -> 
Configuration -> MSAccess) could not be 
read from the resource of the recipe server 

Set up and register recipe server 
(VWRecipeServer.DLL) again 

140 
Database could not be created: X The recipe file X could not be created Check specified path and file name 

(Possibly the file already exists and is 
write-protected?) 
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3.4 User administration („VWUserMgtServer“): 
Nr Error text Description Remedy 

101 Access to VWE-Kernel The VWEngine was not yet started 
completely 

Check log file on previous error 

111 Access to VWS-Configuration 
failed 

Process database access (“Project 
name.VWS”) through 
VisiWinNET.CfgAccess.EXE failed 

Set up and register 
VisiWinNET.CfgAccess.EXE again 

112 Table X in process database Y 
could not be opened 

The stated table X could not be found in 
the process database Y 

System error, call Inosoft hotline 

113 Checksum error with load of user 
class X 

With load of user class X the internal 
checksum does not correspond 

The user database was damaged or 
manipulated manually (either in the 
project file „Project name.VWS“ or else in 
the runtime user database „Project 
name.RTS“). The user class is to be 
deleted and created again. 

114 Checksum error with load of 
authority class X 

With load of authority class X an internal 
checksum does not correspond 

The user database was damaged or 
manipulated manually (either in the 
project file „Project name.VWS“ or else in 
the runtime user database „Project 
name.RTS“). The authority class is to be 
deleted and created again. 

119 DB-Template in the resource not 
found 

The runtime user database template 
(„Project name.RTS“) could not be found 
in the resource of the user administration 
server 

Set up and register the user administration 
server (VWUserMgtServer.DLL) again 

120 Incorrect DB-Template in the 
resource 

The runtime user database template 
(„Project name.RTS“) was destroyed in the 
resource of the user administration server 

Set up and register the user administration 
server (VWUserMgtServer.DLL) again 

121 DB-Template in the resource, 
access denied 

The runtime user database template 
(„Project name.RTS“) could not be found 
in the resource of the user administration 
server 

Set up and register the user administration 
server (VWUserMgtServer.DLL) again 

122 DB could not be created: X The runtime user database („Project 
name.RTS“) X could not be created 

Check specified path and file name 
(Possibly the file already exists and is 
write-protected?) 
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3.5 VisiWinEngine-Manager („VWN-Manager“): 
Nr Error text Description Remedy 

110 Initializing event - Error: X System memory not sufficient System error, kein Windows-Speicher 
mehr frei, Task-Manager -> Check system 
performance 

111 Main window could not be created System memory not sufficient System error, kein Windows-Speicher 
mehr frei, Task-Manager -> Check system 
performance 

112 Wrong project logon:X  

Current project:Y 

A VisiWinNET-Client tries logon to the 
VWN-Manager, but the VWN-Manager is 
started with another project already. Only 
one single VisiWinNET-Server-Project at a 
time can be started on a data processor. 

With the Client Project, probably the data 
processor name or else the server project 
name was entered incorrect.  

113 Error with start of project: System 
is not in design mode 

During start of the VB-application, the 
VWN-Manager is not in the requested 
runtime mode. 

With previous operation of the VWN-
Manager it was not shut down properly. 
Check the VWN-Manager log file on 
occurred errors. Then, close the VWN-
Manager in the VWN-Manager menu (also 
see 1.2.1) manually or else close the 
VWNManager.EXE in the task manager. 

114 Error with project stop: System not 
in run mode 

With VW-Application stop the VWN-
Manager is not in the requested runtime 
mode. 

During operation the VWN-Manager was 
closed prematurely. Check the VWN-
Manager log file on occurred errors and 
afterwards close VB or Project name.EXE 
and restart. 

115 Error: Registry key not found: Y In the registry the specified registry key is 
missing or else the user authorities do not 
allow reading the key. 

Set up runtime system again or else check 
user authorities 

116 Start of VWE-Kernel: Kernel not 
found 

VWEngine is not registered or else does 
not exist 

Set up and register VWEngine again 
(VWEKernel.DLL with VWS-Projects with 
VW32-Kernel; VWEOPC.DLL with the rest) 

117 Start of VWE-Kernel: IF not found VWEngine is registered incorrect Set up and register VWEngine again 
(VWEKernel.DLL with VWS-Projects with 
VW32-Kernel; VWEOPC.DLL with the rest) 

118 VWE-Kernel stop: Kernel not found VWEngine is not registered or else does 
not exist 

Set up and register VWEngine again 
(VWEKernel.DLL with VWS-Projects with 
VW32-Kernel; VWEOPC.DLL with the rest) 

119 VWE-Kernel stop: IF not found VWEngine is registered incorrect Set up and register VWEngine again 
(VWEKernel.DLL with VWS-Projects with 
VW32-Kernel; VWEOPC.DLL with the rest) 

120 Server:X Version:Y could not be 
started 

Stated VWN-Server X with Version Y could 
not be started (either not registered or not 
existing) 

Set up and register stated VWN-Server 
again. Possibly check in the SetUp-wizard 
of files to be set up 

121 Server:X Version:Y delivers 
unknown error 

Stated VWN-Server X with Version Y could 
not be started correctly (Incorrect file or 
else previous version) 

Set up and register stated VWN-Server 
again. Possibly check in the SetUp-wizard 
of files to be set up 

122 Stated Server: X does not support 
the 'IVWService'-Interface 

Stated VWN-Server X is registered 
incorrect or else does not support the 
„IVWService“-Interface for starting 

Set up and register the specified VWN-
Server again. Possibly the „IVWService“-
Interface was not implemented correctly 
with a special created VWN-Server. 

123 Communicator request: wrong 
parameter 

The transferred interface communicator of 
the VB-Application is ZERO 

Internal system error – call Inosoft Hotline 



VisiWinNET VWE-Manager 

Error messages / VisiWinEngine-Manager („VWN-Manager“): / VWEngine    28 

 

Nr Error text Description Remedy 

124 Communicator request: 
Communicator could not be started 

The communicator (also see 1.1.4) to the 
VB-Application is not existing or else not 
registered 

Set up and register the VWEComm.DLL 
again 

125 Communicator request: Service-
Interface is not supported 

The communicator (also see 1.1.4) to the 
VB-Application is registered incorrect 

Set up and register the VWEComm.DLL 
again 

126 Communicator request: 
Communicator could not be 
initialized 

With communicator start (also see 1.1.4) 
of the VB-Application an unknown error 
occurred 

Set up and register the VWEComm.DLL 
again 

127 Communicator request: Max. 
number of clients exceeded 

Login attempt of more than 100 client 
applications 

At the time the number of client 
applications on a server is limited to 100 

128 Communicator deletion: wrong 
parameter 

The transferred interface communicator of 
the VB-Application is ZERO 

Internal system error – call Inosoft Hotline 

129 Communicator deletion: Service-
Interface is not supported 

The communicator (also see 1.1.4) to the 
VB-Application is registered incorrect 

Set up and register the VWEComm.DLL 
again 

130 Communicator deletion: 
Communicator not on 
administration 

Logoff attempt on the server of more client 
applications as there are logged in 

With bad network quality, frequently 
unexpected termination between client 
and server can occur. Possibly the number 
of existing clients will be calculated wrong 
then. Check network. 

142 Print error, WORDPAD not found WordPad.EXE was not found on the data 
processor 

The Microsoft-Application WordPad.EXE is 
used for log file printout. It is part of the 
standard Windows equipment. If the file 
does not exist or else cannot be found in 
the WINDOWS-directory, this error 
message will occur 

143 General print error with 
WORDPAD: X 

WordPad.EXE was found on the data 
processor, but an error occurred during 
printout. 

Start WordPad.EXE manually and try 
printout again 

145 Access to VWS-Configuration 
failed 

Process database access (“Project 
name.VWS”) through 
VisiWinNET.CfgAccess.EXE failed 

Set up and register 
VisiWinNET.CfgAccess.EXE again 

146 Access to global Interface-table 
failed 

GIT (GlobalInterfaceTable) instantiation 
within the VWN-Manager failed 

Internal system error – call Inosoft Hotline 

147 Fatal system error, no sign of life 
or else 10 x cycle exceeding of 
cycle: X 

The watchdog reports that a monitored 
Thread (Cycle) has not reported back in 
the ten times set cycle time to the cycle 
controller and therefore does not work 
correctly. This can be the main cycle, the 
asynchronous recipe administration or else 
the asynchronous data recording. If a 
watchdog server is available in a project, it 
can be responded adequately (i.e.: Restart 
of project/ data processor). 

Either a part of the system does not work 
correctly or else the cycle time set cannot 
be met. In this case the cycle time must be 
increased or the watchdog monitoring is to 
be set manually (also see 1.2.3). If no 
watchdog-server is available in the 
project, the monitoring can be deselected 
(also see 1.2.3). 

148 Speicher geplatzt (Funktion: X)! System-memory not sufficient System error, kein Windows-Speicher 
mehr frei, Task-Manager -> Check system 
performance 

149 Access to IndexTextServer failed The TextServer „VWTextServer.DLL“ was 
not loaded, not found or else is not 
registered in the project, but is required 
for language-switching.  

Set up and register VWTextServer.DLL 
again or else under „VisiWinNET -> 
Project properties -> Server components -
> activate VWLanguage“  
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3.6 VisiWinEngine for VW-32 Projects („VWEKernel“): 
Nr Error text Description Remedy 

102 Wrong data type The reference to a variable or structure, 
used in this process database object is of 
wrong data type 

Re-enter variable (structure) 

103 Variable not defined The variable or structure, used in this 
process database object is not existing any 
more 

Re-enter variable (structure) 

104 Double memory request With the last project start the VW32-
Kernel was not discharged orderly  

Run down the project and delete process 
„VWEKernel.EXE“ using the task manager 

105 Initializing error With the process database object 
initializing an error occurred 

Please note attached error handling 

107 Driver not defined The reference to a structure (driver), used 
in a structure variable definition is not 
existing (any more) 

Re-enter structure 

108 Data offset to big The offset specification of a structure 
variable is bigger than the structure length 

Enlarge structure- (driver-) length 

111 Database not existing The process variable database („Project 
name.DBF“) cannot be found 

Compile process database again, or else 
check if the specified file is included in the 
runtime system setup 

112 Memory not sufficient With the specified function the system 
memory 

Check object on correct data input / check 
system memory 

115 Wrong file name The specified VW32-driver or else the 
specified recipe was not found 

Check data (input) 

119 Configuration parameter is missing The given entry was not found in the 
registry database under 
„HKEY_LOCAL_MACHINE/Software/Inosof
t GmbH/VisiWin/4.0“  

Register project again (in the VisiWinNET-
Dialog under Enhanced) 

125 Ext. driver does not reply The specified VW32-driver was started, 
but does not (yet) take up its job 

Check out specified VW32-driver 
individually with test address 

129 Software protection was taken out The software protection lock was taken out 
in running operation 

Insert dongle again and restart project 

130 Number of objects bigger than the 
software protection allows 

The number of objects, limited by the 
hardware lock was exceeded with the 
process database design. 

Upgrade dongle or else reduce number of 
objects in the process database 

131 No software protection! The 
system runs as demo. 

With project start no hardware lock was 
found. 

Either the hardwarelock (Dongle) is 
missing or the hardwarelock driver was 
not set up correctly (Install VisiWinNET 
again or „DongleSetup.EXE“ under 
„\VisiWinNET\Dongle“ run) 

132 The system ran as demo and shuts 
down now! 

The system ran an hour without 
hardwarelock 

Insert Dongle and restart system 

139 Address error, number of variables 
to big 

In a structure- or external variable 
address, a variable address string was not 
used orderly 

Check the specified address string 

140 Address error, number of variables 
to small 

In a structure- or external variable 
address, a variable address string was not 
used orderly 

Check the specified address string 
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Nr Error text Description Remedy 

142 Address error, variable not defined In a structure or external variable address 
a variable address string was used, 
however the specified formatting variable 
is not (longer) existing 

Check the specified address string 

143 Address error, variable of wrong 
data type 

In a structure or external variable address 
a variable address string was used, 
however the specified formatting variable 
is of wrong data type 

Check the specified address string 

144 Error with the definition of a read 
instruction on the driver 

An unexpected error occurred with 
communication structure creation for the 
specified VW32-driver. 

Call Insoft Hotline 

145 Client could not be logged on, 
ClientID:X 

More than 10 Client-Application logon 
attempts at the VW32Kernel 

At this time the number of clients in use 
with the VW32Kernel is limited to 10. 

146 Driver on UNIVERSAL X is not 
authorized for this software 
protection! 

The specified VW32-Driver cannot be 
operated with this hardwarelock 

For some VW32-Driver a special licensing 
is required 

149 Life cycle monitoring for system 
cycle: logon or ping failed 

Logon at the VWN-Manager Watchdog 
does not work correctly 

Call Inosoft Hotline and forward the 
output error code 

152 CONIN.CFG not found in the 
VisiWin-path declaration 

With location of object information 
concerning an error output, a resource 
error occurred 

Set up and register „VWEKernel.dll“ again 
or else call Inosoft Hotline 

- The connected Server does not 
support the interface IOPCServer. 

The specified OPC-Server is not registered 
correctly 

Register OPC-Server and „OPCProxy.DLL 
again 

- Cannot add a Private Group. With creation of a Private Group an error 
occurred 

Check OPC-Server on the output error 

- Cannot connect to the specified 
OPC Server. 

Connecting to the specified OPC-Server, 
an error occurred 

Check OPC-Server on the output error or 
else if the OPC-Server is located on 
another server, check the user rights 

- Cannot add the specified item. With item creation in the private group an 
error occurred 

Check OPC-Server on the output error 

- The connected Server does not 
support the interface 
IOPCAsyncIO. 

Either the specified OPC-Server is not 
registered correctly or does not support 
the interface „IOPCAsyncIO“ 

Register OPC-Server and „OPCProxy.DLL„ 
again 

- The connected Server does not 
support the interface IOPCSyncIO. 

Either the specified OPC-Server is not 
registered correctly or does not support 
the interface „IOPCSyncIO“ 

Register OPC-Server and „OPCProxy.DLL„ 
again 

- Cannot create an Advise Sinc class 
instance. 

With creation of the asynchronous OPC-
Server Communication a memory error 
occurred. 

Check system memory 

- Cannot advise the recall handler 
(AsyncIO). 

Either the specified OPC-Server is not 
registered correctly or else does not 
support the interface „IOPCAdviseSink“ 

Register OPC-Server and „OPCProxy.DLL„ 
again 

- Cannot advise the recall handler 
(AsyncIO2). 

Either the specified OPC-Server is not 
registered correctly or else does not 
support the interface „IOPCDataCallback“  

Register OPC-Server and „OPCProxy.DLL 
again 

- Cannot write the specified item. With item writing to the OPC-Server an 
error occurred 

Check OPC-Server on the output error 

- Cannot read the specified item. With item read to the OPC-Server an error 
occurred 

Check OPC-Server on the output error 

- OPC-Server not running. After an adequate latency time the 
specified OPC-Server is not yet in 
“RUNNING”- or “TEST”-Mode 

Individual OPC-Server start for test 
purposes 
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Nr Error text Description Remedy 

- The connected Server does not 
support the interface 
IOPCGroupStateMgt. 

Either the specified OPC-Server is not 
registered correctly or does not support 
the interface „IOPCGroupStateMgt“  

Register OPC-Server and „OPCProxy.DLL„ 
again 

- Cannot activate the group for 
AsyncIO, no items read. 

The state of the private group created, 
cannot be switched to „ACTIVE“ 

Check OPC-Server on the output error 

3.7 VisiWinEngine for OPC-Projects („VWEKernelOPC“): 
Nr Error text Description Remedy 

110 FormulaServer: pointer to GIT not 
existing 

Internal error Call Inosoft Hotline 

111 Formula client – table X on project 
database could not be opened 

The indicated table could not be opened in 
the project database 

Check project database path: if the file is 
write-protected, set up project again 

112 Formula server (X) could not be 
started 

The specified VB-Formula server could not 
be started 

Either register formula server or set up 
again 

113 Speicher nicht ausreichend, 
PARAM_SET 

Missing system storage Check memory allocation in the task-
manager 

114 Unknown formula type, type:X of 
formula:Y in server:Z 

VB-Properties for parameter transfer of 
wrong data type 

Check VB-formula 

115 Speicher nicht ausreichend, 
IN_PARAMS oder OUT_PARAMS 

Missing system memory Check memory allocation in the task-
manager 

116 Formula client – could not find 
AliasID "X" in the table "TvbfAlias" 
in the project database 

The project database is defective or else 
was converted incorrect from a former 
version. 

Install project database again 

117 Access to configuration failed VisiWinNET.CfgAccess.EXE could not be 
found 

Set up and register 
VisiWinNET.CfgAccess.EXE again 

118 Shortage of memory space with 
item initializing X 

Missing system memory Check storage allocation in the task 
manager 

119 Warning: OPC-Item (X) is not 
assigned to a group, value cannot 
be read 

The item X could not be logged on to an 
OPC-Server or VW32-Driver orderly 

Check item definition on the OPC-Server 
or else VW32-Driver 

120 The system ran as demo version 
and terminates now! 

The system ran for one our without 
software protection as demo version 

Information 

121 Unknown data type in the 
structure definition – Variable:X 
data type: Y 

An unknown data type was found in a 
structure definition 

Check the indicated variable in the 
structure definition 

122 Bit number with bit variable X <0 
or >7 

The bit number with data type „VT_BIT“ 
can only assume the value between 0 and 
7 

Change bit number of item 

123 CriticalSection - Speicherfehler: X Missing system memory Check storage allocation in the task 
manager 

124 Unknown error in X The function delivered an unknown error Call Inosoft Hotline 

125 PingOPCServer-Thread not 
finished, Error: X 

The OPC-Server-State monitoring could 
not be finished 

Delete the VWNManager.EXE in the task 
manager if necessary and restart project 

126 Error with the VisiWin32-Driver 
start: X 

An error occurred with start of the VW32-
Driver 

Start VW32-Driver in test mode only and 
check function 

127 Error with OPC-Server start: X An error occurred with start of the 
indicated OPC-Server 

Start OPC-Server with test client or 
VWOPCAgent and check function 
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128 StartOPCClient-Thread finished, 
CoInitializeEx incorrect 

The COM-System could not be initialized Call Inosoft Hotline 

129 Error with OPC-Server start, 
Timeout: X 

Even after the start time set, the OPC-
Server is still not in „RUN“- or „TEST“-
Mode 

Increase Start-Timeout in the server-
configuration or else start OPC-Server 
with test client or VWOPCAgent and check 
function 

130 StartOPCServer-Thread (X) not 
finished, error: %2!lu! 

OPC-Server-Start routine could not be 
finished 

Delete the VWNManager.EXE in the task 
manager if necessary and restart project 

131 Shortage of memory space with X Missing system memory Check storage allocation in the task 
manager 

132 Item-read error (X): Y – stream 
length incorrect (Scheduled:<0,Z> 
Actual:<A,B) 

With an OPC-Server with structure 
transfer as „BYTESTREAM“ the given byte 
length of the item does not agree with the 
definition in the OPC-Server (VWS 0...Z, 
OPC-Server A...B) 

Adapt structure definition 

133 Item-read error (X): Y - Z With item read from the OPC-Server an 
error occurred 

Check OPC-Server 

134 Item-write error (X): Y - Z With item write from the OPC-Server an 
error occurred. 

Check OPC-Server 

135 OPC-Server terminated abnormal: 
X 

The OPC-Server was not shut down 
orderly 

Check OPC-Server 

136 Dongle-error With access to the software protection an 
error occurred 

Call Inosoft Hotline 

137 OPC-Server requires system shut 
down (X) 

The OPC-Server started the „Shutdown“-
event, VWS disconnected 

Check OPC-Server 

138 OPC-Server (X) cannot load the 
project - Error: 0xY (Z) 

The Inosoft-OPC-Server is not configured 
for this project 

Configure Inosoft-OPC-Server again 

139 X-Thread (Y) not finished, Error: Z The requested function could not be 
finished 

Delete the VWNManager.EXE in the task 
manager if necessary and restart project 

140 Item (asynchronous-) read error 
(X): Y – stream length incorrect 
(Scheduled:<0,Z> Actual:<A,B) 

With an OPC-Server with structure 
transfer as „BYTESTREAM“ the indicated 
item byte length does not agree with the 
definition in the OPC-Server (VWS 0...Z, 
OPC-Server A...B) 

Adapt structure definition 

141 Cannot load the project The project database could not be loaded Call Inosoft Hotline 

142 Connection to the OPC-Server 
cannot be established 

With OPC-Server start an error occurred Start OPC-Server with test client or 
VWOPCAgent and check function. If 
necessary register again 

143 The connected server does not 
support the interface X  

The indicated interface could not be found 
on the OPC-Server 

Register OPCProxy.DLL in 
the\Windows\System (32)“-directory again 
or check OPC-Server 

144 The connected simulation server 
does not support the interface 

During OPC-Server simulation by the 
simulation server provided in the system 
an error occurred. 

Call Inosoft-Hotline 

145 Cannot connect the recall routine A recall interface could not be found on 
the OPC-Server 

Register OPCProxy.DLL in 
the\Windows\System (32)“-directory again 
or check OPC-Server 

146 OPC-Server does not run (Server-
State: X) 

The OPC-Server is not in „RUN“- or 
„Test“-mode 

Probably, there is a configuration error in 
the OPC-Server or else the connected PLC 
is not working 
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Nr Error text Description Remedy 

147 OPC-Server does not run (Server-
State: X) 

The OPC-Server is not in „RUN“- or 
„Test“-mode 

Probably, there is a configuration error in 
the OPC-Server or else the connected PLC 
is not working 

148 CoInitializeEx in the SetItemValue-
Thread 

The COM-System could not be initialized Call Inosoft Hotline 

149 Error with sending of 
"ShutdownRequest" 

While closing the application the 
connected OPC-Servers are being notified 
of this event; However, an error occurred 
on the OPC-Server. 

If the OPC-Server does not support the 
„IOPCShutdown“-Interface orderly, the 
OPC-configuration function can be 
switched off 

150 Connecting from the 
"IOPCShutdown-Interface" a 
reference numeration error 
occurred 

Connecting with the „IOPCShutdown“ - 
Interface an error occurred on the OPC-
Server 

If the OPC-Server does not support the 
„IOPCShutdown“-Interface orderly, the 
OPC-configuration function can be 
switched off 

151 State is inquired, although the 
OPC-Server is disconnected 

Internal error Call Inosoft Hotline 

152 Group is to be added, although the 
OPC-Server is disconnected 

Internal error Call Inosoft Hotline 

153 The item X cannot be created, 
Error:Y 

With item creation in a Callr-OPC-Server 
an error occurred. 

Check OPC-Server, probably the setting 
„VWS creates items“ is selected in the 
OPC-configuration, although the OPC-
Server does not support this 

154 The item X cannot be added, 
Error:Y 

With item login to an OPC-Server an error 
occurred 

Check OPC-Server on this item with 
VWOPCAgent 

155 The "Active-Status" of the item X 
cannot be changed, Error:0xY 

With item activation/ deselecting on OPC-
Server an error occurred 

Check OPC-Server on this item with 
VWOPCAgent 

156 The "Active-Status" of the item X 
cannot be changed 

With item activation/ deselecting on OPC-
Server an error occurred 

Check OPC-Server on this item with 
VWOPCAgent 

157 The item X cannot be read 
(asynchronous), Error:Y 

With item read on the OPC-Server an error 
occurred 

Check OPC-Server on this item with 
VWOPCAgent 

158 X items cannot be read 
(asynchronous) 

With item read on he OPC-Server an error 
occurred 

Check OPC-Server with VWOPCAgent 

159 The item X cannot be written 
(asynchronous), Error:Y 

With item write on the OPC-Server an 
error occurred 

Check OPC-Server on this item with 
VWOPCAgent 

160 X items cannot be written 
(asynchronous) 

With item write on the OPC-Server an 
error occurred 

Check OPC-Server with VWOPCAgent 

161 The item X cannot be read 
(synchronous), quality:X 

With item read on the OPC-Server an error 
occurred 

Check OPC-Server on this item with 
VWOPCAgent 

162 The item X cannot be read 
(synchronous), quality:Y, Error:Z 

With item read on the OPC-Server an error 
occurred 

Check OPC-Server on this item with 
VWOPCAgent 

163 X items cannot be read 
(synchronous) 

With item read on the OPC-Server an error 
occurred 

Check OPC-Server with VWOPCAgent 

164 The item X cannot be written 
(synchronous), Error:0xY 

With item write on the OPC-Server an 
error occurred 

Check OPC-Server on this item with 
VWOPCAgent 

165 X items cannot be written 
(synchronous) 

With item write on the OPC-Server an 
error occurred 

Check OPC-Server with VWOPCAgent 

166 Not all tables of the project 
database X could be opened 

The project database is defective Set up project again or else create runtime 
system with SetUp-wizard again. 

167 Not all keys of the project database 
X could be found 

The project database is defective Set up project again or else create runtime 
system with SetUp-wizard again. 



VisiWinNET VWE-Manager 

Error messages / VisiWinEngine for OPC-Projects („VWEKernelOPC“): / VWEngine    34 

 

Nr Error text Description Remedy 

168 The table X in the project database 
Y could not be opened 

The project database is defective Set up project again or else create runtime 
system with SetUp-wizard again. 

169 The key X of the table Y in the 
project database Z could not be 
found 

The project database is defective Set up project again or else create runtime 
system with SetUp-wizard again 

170 Start of VisiWin32-Driver – No or 
else wrong universal interface 
<1.5> stated: X 

The interface to the VW32-Driver is 
configured incorrect 

Check interface configuration in the 
development system 

171 Start of VisiWin32-Driver – 
universal interface assigned twice: 
X 

The interface to two VW32-Drivers is 
configured twice 

Check interface configuration in the 
development system 

172 Registry: X [Value]:Y not found or 
blank 

The indicated value on the registry 
database could not be found 

Call Inosoft-Hotline or check with 
„Regedit.EXE“ 

173 Driver could not be started: X The indicated VW32-Driver could not be 
started 

Start VW32-Driver in test mode and check 

174 Driver event not available: X Internal error in the VW32-error (????) Call Inosoft-Hotline 

175 Driver does not answer: X The indicated VW32-Driver could not be 
started 

Start VW32-Driver in test mode and check 

176 VisiWin32-Driver cannot be 
closed: X 

The indicated VW32-Driver could not be 
closed 

Start VW32-Driver in test mode and check 

177 Write queue capacity exceeded - 
VW32Driver: X 

A series of write orders is to be sent to the 
VW32-Driver at once (i.e..: With recipe 
write), which exceeds the max. capacity of 
the write queue 

Capacity of write queue is defined to 2000 
entries at the time 

178 Latency time for driver start 
expired (X ms): Y 

The indicated VW32-Driver could not be 
started 

Start VW32-Driver in test mode and check 

179 VisiWin32-Driver deleted?: X The indicated VW32-Driver was closed 
manually 

During system runtime the VW32-Drivers 
must not be closed manually, restart 
system 

180 Already connected to the OPC 
Server 

Connecting the OPC-Server again, an 
internal error occurred 

Call Inosoft Hotline 

181 Server name cannot be cast into a 
Multi-Byte string 

Internal error Call Inosoft Hotline 

182 CLSID from ProgID cannot be 
determined 

The indicated OPC-Server is registered 
incorrect 

Register OPC-Server 

183 Function 'CoCreateInstanceEx' (X) 
defective 

Internal error Call Inosoft Hotline 

184 Server name cannot be cast into an 
Unicode-String 

Internal error Call Inosoft Hotline 

185 Machine name cannot be cast to an 
Unicode-String 

Internal error Call Inosoft Hotline 

186 The complete server name cannot 
be read from the registry database 

The indicated OPC-Server is registered 
incorrect 

Register OPC-Server 

187 The OPC-Browser on the remote 
data processor cannot be found 

The program (included in the VWS 
package) OPCEnum.EXE is not available or 
else not registered on the remote data 

Set up and register OPCEnum.EXE on the 
remote data processor 

188 On the remote data processor the 
function 
'IOPCServerList::CLSIDFromProgI
D' was processed incorrect 

The indicated OPC-Server is registered 
incorrect on the remote data processor 

Register OPC-Server 
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189 Function 'CoGetMalloc' defective Missing system memory Check memory allocation in the task 
manager 

190 Speicher nicht ausreichend für 
Dongleabfrage 

Missing system memory Check memory allocation in the task 
manager 

191 Project initializing failed Internal error Call Inosoft Hotline 

192 Permitted number of objects 
exceeded 

There are more power tags in the project 
database than permitted through the 
connected dongle 

Upgrade dongle or else delete unnecessary 
items 

193 Permitted number of interfaces 
exceeded (restricted through 
software protection) 

There are more interfaces in the project 
database than permitted through the 
connected dongle 

Upgrade dongle or else delete unnecessary 
interfaces 

194 The runtime system could not be 
logged on in the ROT 

The error occurs under Win2000 
sometimes 

Function is required for special 
applications only, usually project runs 
correct 

195 No Software protection! System 
runs as demo version 

There is no VisiWinNET-Dongle on the 
data processor or else it is not recognized 
by the system 

Possibly set up the dongle driver 
„HLDRV32.EXE“ , if the dongle setup 
failed 

196 Eror with VB-Parameter setting (X) 
in formula (Y) 

With parameter call from a VB-formula an 
error occurred 

Check VB-Formula 

197 Error with VB-Formula (X) run With VB-Formula call an error occurred Check VB-Formula 

198 Error with VB-Parameter read (X) 
in formula (Y) 

With parameter call from a VB-Formula an 
error occurred 

Check VB-Formula 

199 Formula server (X) could not be 
registered in GIT 

Internal error Call Inosoft-Hotline 

200 Function error: X Internal error Call Inosoft-Hotline 

201 Life monitoring for system cycle: 
login or else ping failed 

Internal error Call Inosoft-Hotline 

202 OPC-Client – cannot connect to (X) Connection to the indicated OPC-Server 
could not be established 

Check OPC-Server with test client or else 
the VWOPCAgent 

203 OPC-Client – cannot determine 
OPC-Server-Status (X) 

Function call „IOPCServer.GetStatus“ 
failed 

Check OPC-Server with test client or else 
the VWOPCAgent 

204 OPC-Client – cannot close 
connection to (X) 

The connection to the indicated OPC-
Server could not be terminated 

Check OPC-Server with test client or else 
the VWOPCAgent 

205 OPC-Client – cannot add private 
group: X (Y) 

The indicated private group cannot be 
created on the OPC-Server 

Check OPC-Server with test client or else 
the VWOPCAgent 

206 OPC-Client – cannot delete private 
group (X) 

The indicated private group cannot be 
deleted from the OPC-Server 

Check OPC-Server with test client or else 
the VWOPCAgent 

207 OPC-Client – cannot activate 
private group X (Y) 

The indicated private group cannot be 
activated on the OPC-Server 

Check OPC-Server with test client or else 
the VWOPCAgent 

208 OPC-Client – cannot deselect 
private group X (Y) 

The indicated private group cannot be 
deselected on the OPC-Server 

Check OPC-Server with test client or else 
the VWOPCAgent 

209 OPC-Client – cannot change 
private group state (X)  

The active/passive-state in the indicated 
OPC-Server group cannot be changed 

Check OPC-Server with test client or else 
the VWOPCAgent 

210 OPC-Client (X): Y The indicated function call on the OPC-
Server failed 

Check OPC-Server with test client or else 
VWOPCAgent 
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